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Suggestion / Problems If you have a suggestion about this manual or the system to which it refers please report it to AVEVA Training & Product Support at [email protected] This manual provides documentation relating to products to which you may not have access or which may not be licensed to you. For further information on which products are licensed to you please refer to your licence conditions. Visit our website at http://www.aveva.com



Disclaimer 1.1



AVEVA does not warrant that the use of the AVEVA software will be uninterrupted, error-free or free from viruses.



1.2



AVEVA shall not be liable for: loss of profits; loss of business; depletion of goodwill and/or similar losses; loss of anticipated savings; loss of goods; loss of contract; loss of use; loss or corruption of data or information; any special, indirect, consequential or pure economic loss, costs, damages, charges or expenses which may be suffered by the user, including any loss suffered by the user resulting from the inaccuracy or invalidity of any data created by the AVEVA software, irrespective of whether such losses are suffered directly or indirectly, or arise in contract, tort (including negligence) or otherwise.



1.3



AVEVA's total liability in contract, tort (including negligence), or otherwise, arising in connection with the performance of the AVEVA software shall be limited to 100% of the licence fees paid in the year in which the user's claim is brought.



1.4



Clauses 1.1 to 1.3 shall apply to the fullest extent permissible at law.



1.5



In the event of any conflict between the above clauses and the analogous clauses in the software licence under which the AVEVA software was purchased, the clauses in the software licence shall take precedence.
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CHAPTER 1 1



Introduction



The AVEVA E3D databases hold a large amount of data regarding the Plant that is being modelled. This data may be extracted from the databases as graphical information, i.e. drawings; interface information, i.e. for pipe stressing; structural analysis and structural detailing; or in textual form, i.e. for reports, material takeoff/bill of materials (MTO/BOM), weights and centre of gravities, etc. AVEVA E3D provides two styles of reporting:  Simple Reporting - used for creating reports that are textual  Report Designer - enables users to easily produce high-quality deliverable style reports in various output formats, including CSV, PDF, and MHTML. These reports can include images i.e. Company Logos, information displayed as charts, information based colouring, and include headers and footers.



1.1



Aim



The aim of this training module is to introduce the Reporting facilities that exist within AVEVA Plant, to enable the User to choose a reporting methodology that complements project requirements and best represents the model data.



1.2



Objectives



Through the completion of the training, the Trainee will have sufficient knowledge to complete the following tasks:



1.3







Understand the basic concepts of reporting using Simple and Designer Reporting.







Enable a User to create and run Simple Report.







Enable a User to create and run Report Designer Quick Reports based on search results.







Allow the User to set the reporting criteria based on Hierarchy or Volumes.







Explain the principles of Filtering, Sorting, Grouping, Sub-totalling and Totals.







Introduce some of the formatting that is available in Report Designer.







Explain and implement calculated fields.







Use Charts to display data on reports.







Create summaries of reported data.







Be able to create deliverable reports using Report Designer.



Prerequisites



Trainees must be familiar with the AVEVA E3D system and Microsoft Windows.



1.4



Course Structure



Training will consist of oral and visual presentations, demonstrations and set exercises. Each workstation will have a training project, populated with model objects. This will be used by the trainees to practice their methods, and complete the set exercises.
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1.5



Using this guide



Certain text styles are used to indicate special situations throughout this document:  Menu pull downs and button press actions are indicated by bold dark turquoise text.  Information the user has to key-in indicated by bold red text. Supplementary information or guidance notes will be distinguished by a turquoise information symbol and accompanying text:







Additional information



References to other training guides/sections and documents will be distinguished by a book symbol and accompanying text:







Refer to other documentation



System prompts will be displayed in inverted commas using italicised bold text e.g. 'Choose function'. Example files or inputs will be in the courier new font, utilising colours and styles outlined above where appropriate.



1.6



Entering a AVEVA E3D Model Session



Login to AVEVA E3D using the details provided by the Trainer, for example: Project



Training



Username



A.PIPER (A.PIPER)



Password



A



MDB



A-PIPING



Select Model module.
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CHAPTER 2 2



Simple Reports



AVEVA E3D provides methods to create ‘on the fly’ reports that last for the current session. The Standard Reports method for creating reports is available within the AVEVA E3D Model, Draw, Isodraft modules







For further information refer to the Standard Reporting Reference Manual, that is available as part of the AVEVA E3D On-Line Help.







Throughout this training guide it will be assumed that the Tools tab is being used unless otherwise stated.



2.1



Creating a Simple Report



In the Report group, click the Simple Report button to display the Simple Report form.



2.1.1



Simple Report form



The form contains textboxes that enable the User to specify the output destination, which element types will be included in the report, the report contents and the places to search for the element types. The textboxes are detailed in the following sections.



2.1.1.1 File The File textbox enables a path name and filename to be specified for the report destination in the format \.







By default if no pathname is entered, the file will be created in the %AVEVA_DESIGN_USER%



Checking the Screen checkbox sends the report output to the Command Window, if open, or to an AVEVA E3D Design Command Output window, which opens automatically if the Command Window is not open.



2.1.1.2 Types The Types textbox may contain any valid AVEVA E3D element type, e.g. SITE, ZONE, PIPE, BRAN, ELBO, VALV, FRMW, SBFR, SCTN, GENSEC, EQUI, etc. that will form the basis of the data produced in the report. More than one element type may be specified in the textbox separated by a space. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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Consideration should be given when entering multiple element types, to the attributes that will be used in the report. Element types that have few attributes in common may, depending on the attributes used, have many ‘null’ text column entries.



The reserved word MEMBERS may be used in conjunction with different element types. For example, entering BRAN MEMBERS will report on all of the members of a Branch, e.g. ELBO, TEE, VALV, GASK, FLAN, etc.



2.1.1.3 With The With textbox is a filter to further refine the element types to be used in the report. If left blank, all elements of the specified types will be reported. The With textbox may contain any valid AVEVA E3D expression, for example: Element Type(s)



With syntax



Elements Reported



PIPE



PSPEC EQ /A3B



Pipes with a Pipe Spec. of /A3B.



BRAN



HBOR GE 100



Branches with Head Bore greater or equal to 100 NB.



BRAN MEMBERS



HBOR OF BRAN GT 100 AND HBOR OF BRAN LT 200



Branch members where the Head Bore of the Branch is greater than 100 NB but less than 200 NB.



SCTN



SPREF EQ /DIN-SPEC/HE300A



Sections with a Specification Reference of DIN Spec HE300A.



PANE



MATREF EQ /A36



Panels with a Material Reference of /A36



EQUI



FUNC NE ‘FUTURE’



All Equipment whose Function is not equal to FUTURE.



EQUI



:MANUF EQ ‘Best Pumps Inc.’ OR :MANUF EQ ‘Better Pumps Ltd.’



All Equipment where the UDA :MANUF (Manufacturer) is either Best Pumps Inc. or Better Pumps Ltd.



2.1.1.4 Columns The Columns textbox is where the AVEVA E3D attributes, pseudo-attributes or UDAs are specified. Each attribute forms a column in the report, in which the attribute for each element specified in Types, and filtered by With, is output. Multiple attributes must be space separated. A column may be a valid expression, for example (SUBS(FULLNAME, 2)) which will return the elements full name starting at character 2. The attribute or expression text will form the column header.



2.1.1.5 Hierarchy The Hierarchy textbox enables the elements to search for the specified Types to be defined. A named element may be specified, e.g. /SITE-PIPING-AREA01, by entering the name in the textbox. Multiple named elements may be entered but must be space separated. The report will look for the specified element type(s) below the named element(s) The World may be specified by entering /* or World. Leaving the textbox blank will also use the World as the starting point. CE may be entered in the textbox so that the report will start at the current element, whatever that may be. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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2.1.2



Running the Report



Clicking the Run button runs the report and outputs it to the specified location.



2.1.3



Creating a Simple Report (Worked Example)



In the worked example a simple report of the pipe branches in the ZONE /ZONE-PIPING-AREA01 will be produced. The report will be modified to show only branches of specific bore sizes. Click Report > Simple Report button to display the Simple Report form. Check the Screen checkbox and enter BRAN in the Type textbox. In the With textbox enter HBORE GE 100. This will only include those branches in the report whose head bore is greater or equal to 100mm. In the Columns textbox enter NAME PSPEC HBORE HCON HPOS TBORE TCON TPOS CLLE, i.e. name, pipe specification, head bore head connection, head position, tail bore, tail connection, tail position and centreline length. In the Hierarchy textbox enter /ZONE-PIPING-AREA01, i.e. the name of the Stabilizer ZONE containing the pipes.



The Simple Report form should now look like this:



Click the Run button to output the report to the Command Window (if open) or the AVEVA E3D Design Command Output form and check the output.







The report will not be formatted correctly, i.e. in regular columns, as the Command Window uses a kerned font, i.e. the character spacing is not equal.



Uncheck the Screen checkbox and enter Branches.txt in the File textbox.



Click the Run button to run the report.
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The file can be located in path assigned to AVEVA_DESIGN_USER variable.



Use Windows Explorer to navigate to the file and open it using Notepad or Wordpad. The results should look like this:



Change the With textbox entry to HBORE LT 100. This will only include those branches in the report whose head bore is less than 100mm.



Click the Run button again and check the results in the editor, before clicking the Cancel button on the form.
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Exercise 1 Standard Reporting - Simple Reports Using Chapter 2 as guide, complete the following tasks:  Create a simple report for all nozzles of the equipment in the ZONE /ZONE-EQUIPMENT-AREA01 of the Training Project. The report must include its owners name, the nozzle name, the nozzle nominal bore, the nozzle position and orientation and the connection reference, if any.







Syntax for a nozzle nominal bore is ( P1 BORE ), and the owners name is (NAME OF OWNER), in both cases you must include the brackets, to separate the commands.  Output the report to the Command Window and then to a file named Nozzles.txt.  Use the With textbox to report only nozzles with a nominal bore of 100mm or greater. Output the report to a file named Nozzles.txt.



© Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.



13



www.aveva.com



AVEVA Everything3D (1.1) Reporting TM-1803



© Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.



14



www.aveva.com



CHAPTER 3 3



Report Designer Overview



AVEVA E3D provides a more structured and detailed method of creating reports using the Report Designer function; an add-in to the application comprising an interactive, visual report designing tool. The Report Designer add-in is available in AVEVA E3D Model, Draft, Isodraft modules. The Report Designer utilises two file formats:  Layout Templates (.repx) - contains the report presentation i.e. formatting and graphics. The Layout Template is used to define the basic structure for Report Designer reports but do not contain data and cannot be run.  Report (.repv) – in addition to containing the report presentation, this file format also contains the data source and may be run. Report files do not contain any project settings and are therefore transportable between projects. However, the transfer is only successful where the projects share the same element and attribute structures.







See Chapters 3 -> 5 for details of Report Designer reports.







See Chapter 6 for details of Report Designer Quick Reports, using Layout Templates.



3.1



Accessing Report Designer



In the Report group click Designer button to display the Report Designer add-in.







Report Designer opened in a separate window to the main AVEVA E3D session.



On the Report Designer tab, in the Report group, click the New Report... button to initiates a new report creation process.







See Chapter 4 for further details on the creation of new Reports and the use of the Data Source Wizard.



Alternatively, Report Designer may be populated by opening a pre-defined report by clicking on the Report Designer tab, in the Report group, Open... button and selecting the required report via a Browser.



 3.2



See Chapters 6 and 7 for further details on the running of a pre-defined report, including direct access via collection in AVEVA E3D Design.



Report Designer User Interface



The Report Designer user interface has the following main elements:
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Microsoft® Office Fluent™– based user interface



Tool Box



Field List & Report Explorer



Report Canvas



Property Grid Sorting & Grouping



Tool Box



-



Contains standard controls that may be added to a report e.g. Shapes, and Charts.



Report Canvas



-



Main working area where the report is designed, formatted and previewed.



Field List



-



Displays the Data Source Columns.



Report Explorer



-



Presents a tree-view of the Report structure and allows quick navigation to report presentation controls.



Property Grid



-



Contains and defines report settings and controls. The grid is context sensitive to the current selection in the Report Canvas.



-



Allows application of grouping and sorting to the reported data.



-



Allows the User to switch between reporting modes. The User will principally work in, and switch between, the Report Designer, Print Preview and HTML View modes.



Grouping Sorting



and



Mode Tabs



3.2.1



Designer Mode



A general view of Report Designer mode is shown below:
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The Report Designer mode allows the User to define the layout, format and contents of a report. The task is aided by the Standard Controls allowing, for example, the addition of labels, picture files i.e. a company logo, and graphical charts derived from the report data. In addition, the User is able to create and modify special calculation fields. Such fields are used to manipulate data returned from standard AVEVA E3D attributes, applying expressions to control the reported output.



3.2.2



Preview Mode



A general view of Print Preview mode is shown below:
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AVEVA Everything3D (1.1) Reporting TM-1803 The Print Preview allows the User to display the report as it will appear when printed. When working in the Print Preview mode the reported fields are replaced with the relevant data from the bound Data Sources.



3.2.3



HTML View Mode



A general view of HTML View mode is shown below:



Where a preview or HTML view of a report is displayed, returned data is limited to the first twenty records. The report preview will be cached and any changes to the underlying data will not be shown until the User runs the report or re-opens the Report Designer.



 3.3



If filters are added to a data source this may impact on the performance of previews. Where previews are shown in a Quick Report all data is shown.



Printing & Exporting Reports



The opportunity to print and export reports is presented to the User on running the report (initiated by clicking in the Report Designer tab, in the AVEVA group, Run Report button). The report is executed and a full data set is returned and displayed in a new Run Report window. The window provides the User with facilities for printing,changing page setup, navigation, zooming, changing background color and adding watermark, exporting to various file formats, and publishing the report in PDF format, with data and associations if configured, to AVEVA NET.



On the Report Designer tab, in the AVEVA group, click the Run Report... button to initiate the new report creation process.
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Print Options.



Page Setup Options.



Navigation



Zooming



Page background colour and watermark
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Export Report (in one of the available formats) and Save to File.



Export Report (in one of the available formats) and Attach to Email.



Publish to AVEVA NET.



3.4



Report Designer Workflow



The flowchart outlined below summarises the basic workflow a User will follow when working with the Report Designer.
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A set of sample reports are included with the Report Designer tool, including both Layout Templates and Reports. The reports are designed to work with the sample database and may be accessed by clicking on the Report Designer tab, in the Report group, Open... and using the navigation Browser to locate the required folder e.g %AVEVA_DESIGN_DFLTS%\data\reports
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CHAPTER 4



4



Report Designer – Report Creation



Having established a context to the Report Designer in the previous Chapter, the following Chapter will detail the creation of a report. Select the Report group Designer button and create a report through the completion of the following Sections and by following the lead of the Trainer.



4.1



Creating a New Report - A Worked Example



The report creation process begins with the instigation of a new report and the definition of a layout.



On access to Report Designer, click the Report Designer > Report > New Report...



The New Report form is displayed.



The New Report form allows the selection of a pre–defined Layout Template. The User is able to locate a required template via the Look In pull-down menu and selecting Product, Project, User or locations. The latter option prompts a Browse For Folder window in which, the User may select an appropriate location e.g. %AVEVA_DESIGN_DFLTS%\data\reports. The selected location is subsequently added to the Look In pull-down menu and the Layout Template list is updated.
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The selection of a required template from the Layout Template list displays the identified template in the Layout Preview window.







The Layout Templates (.repx) have only presentation items and are not bound to any data. A Template may incorporate tables for laying out the data, company logos etc….



From the Look In pull-down menu select the Product location. Select an A4-Portrait Layout Template and click Create to create the new report.







The Property Grid can be used to define or modify the page size at any time during report creation. With the report section selected, the Paper Kind property pull-down list is used to select an appropriate page size e.g. A4. The Paper Kind property is located in the Page Settings section of the Property Grid.



4.1.1



Saving the Report



On report creation it is prudent to save the report; this has the associated action of naming the Report. Click the Report Designer > Report > Save... > Save As Navigate to your reports directory or as directed by the Trainer and save the Report as Training_Report.repv. The Report Designer window is updated to reflect the new report name within the Title Bar.



4.2



Report Data Source



The following sections outline the sources of project data that can be used to create and customise datacentric reports to meet project or customer requirements. The data source is integrally bound to the report, with controls in the report linked to data fields in the data source. A Report can be bound to data from the AVEVA E3D project database. Once a data source has been defined, the elements from within that source can be further restricted by defining a data source scope.



4.2.1



New Data Source from Individual Queries



In this instance, the data to be reported is created as required by the User using the Report Designer Data Source Wizard, or the Search utility within AVEVA E3D Design.







Refer to Section 4.3 for further information on the use the Data Source Wizard and Chapter 6 for further information on the use of the Search and Collection for Quick Reports.
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4.2.2



Pre-defined Data Source from Stored Queries



Report Designer is able to report and bind to pre-defined data from stored queries known as Database Views. A Database View may be shared across a project. There are three types of Database Views available: Element Views



An Element View is automatically created and maintained by the system. These Views are provided for all base Element Types within the project schema and are available to all Users.



Project Views



A Project View is a user-defined View of the data and is stored within a Lexicon dictionary database. The Views are available to all Users. These Views may contain more complex data i.e. the combining of an element’s attributes (UDA and Pseudo), from associated items, and attribute based expressions.



User Views



User Views may be copies of Project or Element Views, or views an Administrative User has created and stored locally. It is envisaged that an Administrator would create and refine individual User Views prior to exposing the View to all Users by copying it to a project dictionary database, where it would become a Project View.



 4.3



Refer to TM-1862 AVEVA Plant Everything3D Lexicon Training guide for further information on the formation of Database Views.



Data Source Wizard



The Data Source Wizard may be used to define and bind a Data Source (new or pre-defined) to a report.



The wizard is initiated by clicking AVEVA > Data source button to display the Data Source Wizard form.



Through a series of steps the Data Source Wizard enables the user to create or modify a Data Source. New Initiates a series of steps to define a New Data Source based on an individual query. Copy Initiates a series of steps to define a Pre-defined Data Source to be copied and edited as the basis of a report. The User is able to select from Element, Project and User Database Views. Edit Allows modification of the data source for the current report. This option is not available if the current report does not have a defined data source.







The Data Source Wizard form can be resized to show more information if required.
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4.3.1



Data Source Wizard: Defining a New Data Source



A new data source is defined by the User selecting the New radio button and Next > on the initial Data Source Wizard form. The Properties page of the wizard is then displayed. A name for the new data source is automatically generated within the Name: textbox. The Name and Description may be altered by the User to better describe the element(s) the data source will use



4.3.1.1 Base Element Types On clicking Next>, the Base Element Types page of the wizard is displayed.
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For an MTO report is likely that more than one Base Element Type will be selected.



The Database Types Filter pull-down menu is used to filter the available elements i.e. to display only Design elements. The list of available elements shown may be filtered further by typing in the filter box at the top of each column within the Available Element Types grid.



In the example here, the Database Type has been filtered to Design and the Available Element filtered to elements name start BR... by typing BR in the filter box for the Name column.



Selecting the required available element type, the element may be added to and removed from the Base Element Types list using the central arrow buttons. In the example below, the Branch Element Type has been added to the Base Element Types list and will consequently be reported as the data source.







The Ctrl and Shift keys may be used to make multiple element selections.



4.3.1.2 Filters On clicking Next>, the Filters page of the wizard is displayed.
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Using this step of the wizard, filters may be added to limit the elements returned by the data source. There are two types of filtering available: Attribute Filters and Expression Filters. A new filter is added by clicking the Add Filter button beneath the respective filter lists. Multiple filters may be defined and combined. The Attribute Filter allows a simple attribute based comparison through entry or selection in the fields provided: Attribute, Operator and Value.



The Expression Filter allows for the direct entry of more complex PML1 expressions e.g. PURP OF SITE eq ‘Pipe’ will return elements where the Purpose of the owning SITE is set to Pipe A Filter may be deleted by selecting the required filter and clicking Delete Filter.



4.3.1.3 Columns On clicking Next>, the Columns page of the wizard is displayed.
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The attributes of the base elements of the data source are displayed in the Available Columns box. From this list, the User is able to choose the Attributes (Fields) required for the report by populating the Data Source Columns list. If multiple elements have been selected for the data source, then either all attributes of these element types may be listed by clicking the All Attributes radio button, or only those common to all the selected element types may be listed by clicking the Common Attributes radio button. The Available Columns list has the following column headings:  Definition



Attribute Name or AVEVA E3D expression.



 Name



Field description text – as displayed in the Report Field list.



 Description



Reporting text for the Attribute, as defined in AVEVA E3D Lexicon module.



 Data Type



AVEVA E3D attribute data or returned value from an expression.



Selecting the required Available Column(s), the Field(s) may be added to and removed from the Data Source Columns box using the arrow buttons.







The Ctrl and Shift keys may be used to make multiple element selections.
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The Data Source Columns list may be edited as per the User’s requirements. To edit an entry, a cell is selected in the row and directly edited. The exception is the Data Type column which, is edited via selection from a pull-down menu.







When using Expressions the user must make sure that the Data Type is set correctly otherwise the result output in the report might not be as expected.



Following one or more columns being selected, PML1 expressions or Pseudo attributes may be typed into the Data Source Columns Type Definition… field, with the resulting output available for use in the produced report. The new Definition entry is added to the bottom of the Data Source Columns list, where it may be edited as previously described. To delete a user-defined Definition, the row is selected in the Data Source Columns list and the Delete key used. The below list highlights valid user-defined Definitions (Pseudo Attributes and expressions) that may be used and the associated data type: Definition



Description



Data Type



not(unset(SCHLNK))



Returns True or False dependent on SCHLNK being unset, and then reversing the answer to give the result



Boolean



STVCOM( /TagStatus )



Comment of the current item’s status control setting



String



FLNN



Full name of item



String



CONNECTIONS



Array of the connected items



String



DBNAME



Name of the Database the item is stored in



String



When a Definition is entered, care should be taken as it is not checked as to whether the attribute name is valid or an expression has the correct syntax. On defining the required Data Source Columns for the report, clicking Finish closes the wizard and populates the Report’s Field List.







If the Data Source requires modification, the Data Source Wizard may be re-run, and the Edit option selected. The User is then able to modify the input information as required through the described steps.
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4.3.1.4 Field List Fields, or Definitions, selected or created as part of the Data Source Wizard process are displayed in the Field List of Report Designer.



The Fields are displayed in the format ., where is the Name entered on the Properties page of the Data Source Wizard, and is the value from the Name column of the Data Source Columns on the Columns page of the Data Source Wizard. The icons adjacent to the Fields indicate the field’s Data Type: Icon



Data Type Table or Array of Data Text Reference or a value with units Calculated Field Parameters Boolean Star indicates an invalid Syntax Integer value



4.3.2



Data Source Wizard: Copying a Data Source - A Worked Example



The following Worked Example will utilise a pre-defined data source – a Database View. Initiate the Data Source Wizard by clicking AVEVA > Data source button. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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Select the Copy radio button and click Next > to prompt a series of steps to define a Pre-defined Data Source to be copied and edited.



4.3.2.1 Copy Data Source



The Copy Data Source page of the Data Source Wizard allows the selection of an available, predefined data source to base the report on.



The View Definition Set pull-down menu allows the selection of the Database View type required: Element Views, Project Views or User Views. Depending on the Database View selection, the View list is updated. The Database Types Filter pull-down menu is used to filter the available elements i.e. display only Design elements. Select Element Views from the View Definition Set pull-down menu. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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Select Design from the Database Types Filter pull-down menu. Select Design BRANCH from the Views List to select the Branch Element View.



On selection, click the Next > button to proceed to the next stage of the Wizard.



4.3.2.2 Properties The Properties page of the wizard is displayed. A descriptive name and detailed description for the new data source is automatically generated.



Ensure the Default entries are as follows. Name:



Design BRANCH



Description:



Branch



Click the Next > button to proceed to the next stage of the Wizard.



4.3.2.3 Base Elements Types The Base Element Types page of the wizard is displayed.
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Due to the previous selection of an Element View, the Base Element Types list is automatically populated with the associated base type: BRAN (Branch). On verification of the above, click the Next > button to proceed to the next stage of the Wizard.



4.3.2.4 Filters The Filters page of the wizard is displayed.



Due to the previous selection of an Element View, the Filter list is automatically populated with the associated (Attribute) Filter: ACTYPE Equals BRAN. On verification of the above, click the Next > button to proceed to the next stage of the Wizard.



4.3.2.5 Columns The Columns page of the wizard is displayed.
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Due to the previous selection of an Element View, the Data Source Column list is automatically populated with the associated Columns. On verification of the Data Source Columns list, click Finish to close the Wizard. The Report Designer will update to be as follows with the Field List populated with the defined Data Source Columns.



 4.4



The Data Source may be modified using the Edit option on the Data Source Wizard.



Populating the Report Canvas



The following section focus on the addition of data to the Report Canvas and subsequent formatting. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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4.4.1



Report Bands



Prior to populating the Report Canvas with data using the specified Data Fields, it is important to understand the areas of the canvas and how they may be used. The Report Canvas is divided into a number of areas called Bands which, control the layout of the report and contain reported controls and fields. A (blank) report will typically contain the following Bands:



The Report Header and Report Footer bands are printed in the report only once at the Head and Foot of the report respectively. The Page Header, Page Footer, Top Margin and Bottom Margin bands are printed on every page of the report. A Detail band is printed for each data entry the Data Source returns, while the Group Header and Group Footer bands are printed for each data group. Page 2



Top Margin



Top Margin Page Header



Page Header Group Header



Group Footer Group Header



Detail



Detail



Detail



Detail



Group Footer Group Header Detail Detail



Left Margin



Report Header



Detail Group Footer Report Footer



Right Margin



Page 1



Right Margin



Left Margin



The Bands on a typical report, where the report spans multiple pages, can be summarised as follows:



Group Footer Group Header Detail Page Footer



Page Footer



Bottom Margin



Bottom Margin
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Bands may be added to the report via a right-click context menu in the Report Canvas and selecting the option Insert Band. The required band to be added to the report is selected from the available options listed in the sub-menu e.g. GroupHeader.



4.4.2



Adding Data Fields to a Report - A Worked Example



In order to view and print data, Data Fields are required to be added to a Detail band in the Report Canvas. There are two methods to add Data Fields to the report:  Drag and drop the Data Field directly to the Report Canvas  Drag and drop a Label to the Report Canvas before binding to a field.



4.4.2.1 Drag & Drop the Data Field Select the Name.Design BRANCH field in the Field List and drag it into the Detail Band of the report Canvas. The surrounding box represents the size of the field entry in the canvas and during the placement action, a number of (magenta) alignment aid lines appear from the box’s edges. Drag the Data Field until the left edge is aligned with the left margin of the report and the top edge is aligned to the band as shown in the following screenshot.



On placing the field, the box is labelled with the represented Data Field’s name.
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4.4.2.2 Binding a Data Field to a Label To demonstrate the alternative method of adding a Data Field to the report, drag a Label from the Tool Box (Standard Controls) and, using the alignment lines as a guide, drop it adjacent to the Name field in the Detail Band. On placement, the box is shown as a Label e.g. label2.



With the placed Label selected, click the > symbol at the top right-hand corner of the label to display the Label Tasks menu.



Click the Data Binding pull-down menu, expand the tree and scroll down the list of fields to select the Data Field: HEAD BORE.Design Branch.
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After selection, click the < symbol to hide the Label Tasks menu. The Label control is now bound to the data field. The Label control reflects the binding by updating to display the field Name.



4.4.2.3 Data Field Preview To ensure the report is returning data from the Data Source and in an appropriate format, it is prudent to check placed Data Fields prior to running a report.



Click the Print Preview tab to view the placed Data Fields as they will be printed.







If the Data Source used for a report encounters an error when attempting to collect data, and because of this error is unable to return a Field value, an error message will be substituted for the Field value. An error may occur, for example, if an incorrect PML1 expression is used to determine a field value. Where an error is encountered the substitution text in the report is: !!Error



The vertical space between the data records highlighted here is a result of the Detail Band height in the Report Canvas.







There are no gaps for the ReportHeader or the PageHeader bands due to a lack of controls or labels in those areas; however, page margins are displayed.



To reduce the Detail Band height, navigate to the Report Designer mode and select the bottom of the Detail Band boundary box (noting change in cursor to vertical arrowed line). Drag the cursor upwards to the base of the Data Field labels.
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4.4.3



Adding Column Headings (Worked Example)



The next step is to describe each data column by adding a Column Heading. Adding a Column Heading is achieved, as with adding a Data Field, by placing a Label control on to the Report Canvas from the Tool Box (Standard Controls). As per convention, the Column Heading is required on each page of data but not at each data instance. To this end, the Label is placed in the PageHeader band.



Drag two Label(s) onto the PageHeader band, using the positioning lines to aid alignment with the two Detail Band fields.



The Label text denoting the first column may be altered by double-clicking the Label and modifying the text by typing the required column heading.



Using this method, alter the first Column Heading to: Branch.



Alternatively, the Column Heading can be entered by selecting the Label and clicking the > symbol to display the Label Tasks menu and entry in the Text textbox.
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Using this method alter the second Column Heading to: Head Bore







A label may also be edited using the Property Grid – Text property field within the Data section.



As completed for the Detail Band, reduce the PageHeader height to minimise the gap between the Column Heading and reported data. Save the report. The report format in Report Designer and Print Preview modes should now be as follows: Report Designer Mode



4.4.4



Print Preview Mode



Formatting Styles & the Report Explorer



Each report control and band has a group of properties that allow the User to change the presented style and format i.e. font, text size, background / foreground colours and borders. On creation, each control inherits properties from the report object above it. However, the User is able to break this inheritance by explicitly changing the property of an individual item. Where the property of an owning parent is altered, the child item will not be changed automatically.



The Report Explorer (accessed via the tab adjacent to the Field List) illustrates the hierarchy of a report and indicates how formatting may be inherited by controls. Note the yellow box indicator with the Detail Band labels. The indicator signposts the labels as being bound to fields attached to a Data Source. The selection of a node in the Report Explorer selects the associated item in the Report Canvas when in Report Designer mode.
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4.4.4.1 Altering the Font Format (Worked Example) The following section will demonstrate how to alter the font of the created Column Headings.



Select the Branch Column Heading label



In the Property Grid, select the Font property field within the Appearance section, and click on the display the standard windows Font form



button in the cell to



Select the following settings: Font:



Arial



Font style:



Bold



Size:



11pt



Click the OK button to close the form



On closing the Font form, the Label is updated to reflect the revised font.



Select the Head Bore Column Heading label and, using Report Designer > Font > ...., set the label to the same described font style.
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To demonstrate the ability to change multiple Labels, select both label fields (use keyboard CRTL button), and click the Align Centre button



from Report Designer > Font.



Both labels within the PageHeader Band are now aligned to the centre. In the Property Grid, change the Background Colour property in the Appearance section to LightBlue using the pull-down list Save the report. To unset a locally set property i.e. to enable the parent setting to rule, select the property in the Property Grid and select the Reset option via a right-click menu to remove the local setting.







On changing a control setting within the report, the Property Grid will display the changed value as Bold text.



4.4.5



Changing the Label Size



A Label size may be altered in size by selecting the label to prompt eight label grab handles. The central handles are used to modify the label size in a constrained vertical and horizontal direction, and the corner handles are used to stretch or contract the label in all directions. On moving the handles, alignment lines extend from the corners of the label to aid the User in positioning the label relative to other controls and the page margins. If the bounding box overlaps another bounding box or margin, the overlapping area is shaded red to warn the User that the returned data may overlap. Below are examples of overlapping labels and a label overlapping a margin.
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Exercise 2 Report Designer - Additional Fields & Formatting Using Chapter 4 as a guide and the Worked Example Report (Training_Report), complete the following tasks:  Use the Data Source wizard to add the Pseudo attribute CLLE (Cut length) as a Data Field.  Change the size of the page to A3 Landscape.  Add the following attributes from the Field List, to the report 



PSPE



Specification







HCON



Head Connection







HPOS



Head Position







TBORE



Tail Bore







TCON



Tail Connection







TPOS



Tail Position







CLLE



Cut Length



 Make the order of the fields: Name, PSPE, HBORE, HCON, HPOS, TBORE, TCON, TPOS, CLLE  Add headings to the fields, and make them as shown below.  Add a Report Header with the title Branch List.  Save the report. The report should look similar to below in Report Designer mode:
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Report Designer - Advanced Formatting



The previous chapter established a report template and introduced basic formatting. Chapter 5 will expand on formatting tools and introduce graphical reporting tools available to the User.



5.1



Adding Borders - A Worked Example



A border may be added to an individual control within a report, or to all the controls within a report band. It should be noted that the border line resides on the inside of the boundary box. Consequently, on the occasion where two labels are located immediately adjacent, the displayed line thickness appears to be doubled where the two labels meet. The simplest way of eliminating the double line effect is to remove the border from one side of a label within the row.



For example, specifying the Branch label to have both a Left and Right border, and the Spec label to have solely a Right one removes the double line.



Continuing with report Training_Report, borders are required to aid the viewing of the reported data. This task includes the addition of borders to the Column Headings to separate them from other Column Headings and the reported data. Select the PageHeader band, and in the Property Grid, select the Borders property.
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With regards to modifying an individual label, the Branch heading label requires a left border to enclose it. Select the Branch label and from the Property Grid select the Borders property.



Click the arrow to display the Border setting menu. The Top, Right and Bottom borders are already set, due to being inherited from the PageHeader band. From the Borders menu, click the Left border button. Click anywhere on the Report Canvas to close the menu.



As described previously, modification is required to avoid the display of double thickness borders. Multi select the labels on the bottom row of the PageHeader Band as shown:



Select the Borders property in the Property Grid, and click the arrow to display the Border setting menu. Remove the Top border and switch to Print Preview mode to examine the resulting report:
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Exercise 3 Report Designer - Formatting a Report Using the previous section as a guide, and the Worked Example report (Training_Report), complete the following tasks:  Add borders to the Detail Band labels, using the following property settings: Border Colour LightGray Border Width 1 



Change the Font style of the Detail bands labels, using the following property settings:



Font Font style Size



Arial Regular 9pt



 Ensure the Detail Band labels are aligned to best present reported data.  Save the report.
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5.2



Rule based Formatting - A Worked Example



In addition to applying formatting to the report bands and individual controls within the bands, formatting rules can be applied to the conditions of an individual field or several fields. Before formatting a control using a rule, styles are required to be added to the report’s Style Sheet. The Style Sheet is a storage area in the Report where a number of different formatting styles are defined and the condition of their use assigned. As an example, a common Style Sheet required in a report is alternate row colouring where the odd numbered rows are coloured white and the even row numbers contrast in a darker hue.



5.2.1



Adding Styles to the Style Sheet



Styles are added to the Style Sheet with the use of the Styles Editor. The Style Editor is accessed by selecting either the Styles property or the Style Sheet property in the Property Grid. The properties available are dependent on the control selected in the Report Canvas. Using the Property Grid, select the Report option from the grid’s main pull-down menu and select the property Style Sheet within the Appearance section. Click the button. The Styles Editor window is displayed.



To create a new Style, click the green Style Editor with Appearance properties.



icon on the menu bar to populate the right window of the



Select the (Name) property and enter the text Wheat.



Select the Background Colour property and from the pull down menu, select the Web tab, and select the colour Wheat.
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On selection, the pull-down menu will close and the Background Colour property will contain the text Wheat and the colour box will be filled with the wheat colour as shown.



Create a new style by clicking the green icon from the Style Editor menu bar. Set the (Name) property to Normal. The Appearance properties remain as their default values. Click Close to dismiss the Styles Editor window.



5.2.2



Applying Styles from the Style Sheet



As alluded to in Section 5.2, a colour banding effect may be achieved by the following.



Ensuring the Detail Band is current in the Report Canvas, navigate to the Appearance section of the Property Grid and select the Styles entry. Expand the Styles node by clicking the adjacent + button to display the three avaliable Styles for the Detail Band.
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Select the Even Style property. From the pull-down list the Styles created in the previous example can be observed. Select the style named Normal.



Select the Odd Style property and from the pull-down list select the Style named Wheat.



Switch to the Print Preview tab, and the report will resemble the following:



With the report staring at Row 0, note the even rows have a background colour of White, while the odd numbered rows have a background colour of Wheat.



5.3



Defining Formatting Rules – A Worked Example



Formatting Rules allow the User to format Bands and individual controls using rules (conditions) that are controlled by the information returned in the report.



5.3.1



Creating a Formatting Rule



The Formatting Rules Editor is used to add Formatting Rules to the report.
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The Formatting Rules Editor is accessed by selecting the Formatting Rules property in the Property Grid. Ensuring that the Report level in the Report Explorer is current, select the Formatting Rules property in the Property Grid and click the



button.



The Formatting Rules Editor form controls the creation and the application of the Rules to a control.



To add a Rule to the Rule Sheet collection, click the Edit Rule Sheet… button to display the Formatting Rules Sheet Editor.



To create a rule, click icon on the Formatting Rule Sheet Editor menu bar to populate the right window of the Editor with properties controlling the Behaviour and Appearance of the rule, plus the condition in which the rule will be activated. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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Enter a (Name) of PSPEC_A1A these are descriptive to aid recall as to their purpose later.







Names cannot contain spaces.



Set the Foreground Colour to Red via the Web tab of the pull-down menu. A preview of the Formatting is displayed at the base of the Formatting Rule Sheet Editor window.



The next task is to set a condition; this will activate the Formatting Rule when it is applied to a control.



Navigating to the Behaviour section of the Properties Grid, select the Condition property and click on the Condition Editor.



button to display the



The Condition Editor allows the User to enter an appropriate expression to return the required value that is to be used as a display field, or to be used for changing the format of the report.



The Condition Editor contains a window where an expression text may be input and a row of operators. The bottom left window allows the User to select different subsets of expressions. These are then displayed in the centre bottom window, while the right hand window displays helpful information regarding the selected functions or field type.
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The field is enclosed in square brackets to signify that it is a field value and not a text string.



From the row of Operator icons across the centre of the Condition Editor select the = (equals) sign to place two equals signs (= =) in the expression window and enter the text ‘A1A’ to complete the required expression.







The inclusion of the single quotes is required as all text has to be enclosed in quotes.



The expression should now read: [PSPE] == ‘A1A’ Click OK to close the Condition Editor.



5.3.2



Assigning a Formatting Rule to a Control



The Worked Example requires that when a row is returned and the PSPE is equal to ‘A1A’, the entire row will be formatted according to the rule’s condition. To this end, complete the following steps.



Select the Detail Band on the Report Canvas and click the > symbol to open the Detail Tasks context menu.



Click the



button adjacent to the Formatting Rules option to display the Formatting Rules Editor.



The Rules available in a report: area of the editor is populated with the previously created rule PSPEC_A1A. The Rules applied to a control: area of the editor lists the rules that are applied to the selected report band.
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Rule(s) are assigned or unassigned to the control(s), by selecting the required rule(s) and using the arrow buttons Select the previously created rule PSPEC_A1A, and click the button to move the rule to the Rules applied to a control: list.



Click OK to close the Formatting Rules Editor. Select the Print Preview tab and observe how the Formatting Rule has applied to each row where the PSPE is equal to A1A.



5.4



Calculated Fields - A Worked Example



Calculated Fields allow the User to pre-process a report's data based on user-defined expressions. Calculated fields allow the creation of complex expressions applied to one or several data fields from the data source. In addition to outputting the expression values as part of the report, the Calculated Field may be used to both sort and group a report’s contents. In addition, there are special calculated fields that allow specific AVEVA E3D conversion functions. A useful example of this function is the ability to set a field to ensure the returned value is always in a specific unit. This is useful when considering a report’s output is based on the User’s current display units and there is an opportunity for separate Users to run the same report and return different units. In regards to the Worked Example report, calculated fields will be created and will replace a number of the existing fields.
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5.4.1



Calculated Fields – Units Conversion



Currently the developed Worked Example Branch List report returns the Cut Length from the data source with units of millimetres (mm). With the use of Calculated Fields, the Cut Length will always be returned in metres (m).



5.4.1.1 Creating a Calculated Field The unit conversion will be achieved with the use of a calculated field, and the addition of a conversion expression.



To create a calculated field within the data source, select the Cut Length.Design BRANCH field from the Field List. Using the right-click context menu on the field, select the menu option: Add Calculated Field.



On selection, an empty calculated field is created in the Property Grid.



Select the Name property and give it a descriptive name of CutLengthMetres.
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5.4.1.2 Entering an Expression



Using the Property Grid for the Calculated Field, select the Expression property and click the



button.



On selection the Expression Editor is displayed. The Editor’s appearance is similar in use to the previously described Condition Editor.



The following expression is required: FormatDouble([Field], ‘’, Precision , ‘’) where ‘’ is optional.



© Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.



57



www.aveva.com



AVEVA Everything3D (1.1) Reporting TM-1803



In the expression window, enter: FormatDouble( Select the Fields option to list the available fields. Locate the CUTLENGTH.Design BRANCH field from the central window and double-click it to add it to the expression window. The field name is enclosed within [ ] (square brackets) to denote it is a field within the expression. The expression read:



should



now



FormatDouble([CUTLENGHT.D esign BRANCH] In regards to the unit conversion: the new units are m, the precision required is 2 and the display units will be m. To complete the expression, after the field name, enter: , ‘m’, 2, ‘m’).



The final expression will be as follows: FormatDouble([CUTLENGHT.Design BRANCH], ‘m’, 2, ‘m’) Click OK to close the Expression Editor. The Property Grid will now display the entered expression in the Expression property field:



5.4.1.3 Binding the Calculated Field to a Label On creating a Calculated Field, it must be added to the report. With the Worked Example report, a field label already exists for CUTLENGHT; this label may be used and altered so that it is bound to the calculated field CutLengthMetres instead of the original data source.
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Select the CutLength field label in the Detail Band of the report. Click the > button at the top of the label. The Label Tasks menu is displayed. Select the Data Binding option, and select the CutLengthMetres.Design BRANCH field from the pull-down list of fields. To close the menu, click the < symbol at the top left of the menu area.



5.4.1.4 Previewing the Calculated Field To preview the result of the calculated field, select the Preview tab. The Length column data is now displayed in metres.



5.4.2



Calculated Fields – Using String Functions



Calculated Fields may be used to strip text from a long text string, with the resulting text displayed in the report. The Head Position of the reported Branches is displayed as a single string, typically: W 316640.00mm N 300879.99mm U 101349.77mm. To demonstrate the use of a Calculated Field, the three coordinate parts will be separated into the respective West, North and Up positions by separating out the relevant piece of text from the position string.
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5.4.2.1 Creating Calculated Fields Select the HEAD POSITION.Design BRANCH field in the Field List and, as described previously, create three calculated fields with the following descriptive names: 



HEADWESTING - West Position







HEADNORTHING - North Position







HEADUPING – Up Position



The Field List is updated to include the three calculated fields. An expression is required to extract the relevant parts of the string for the head position string.



5.4.2.2 Entering the West Expression Navigate to the Field List, and select the Edit Calculated Fields… option from the right-click menu to display the CalculatedField Collection Editor form and all the calculated fields that are associated with the report. Using the CalculatedField Collection Editor select the HEADWESTING field to display the associated properties on the right-hand side of the form. Navigate to the Data section, select the Expression property and click the adjacent



button to display the Expression Editor.



As part of the entered expression, the function Substring will be used. Select Functions from the bottom lefthand window and from the central window select the Substring(‘’, , ) function. The bottom right-hand window expands on the chosen function to give a detailed description and required parameters.







The substring function returns a substring extracted from the specified string. This function requires two or three operands:



Using 2 operands, the substring will be extracted from the beginning of the original string: 1 - An original string. 2 - An integer that specifies the length of the substring. Using 3 operands, a substring can be subtracted starting from any position in the original string: 1 - An original string. 2 - An integer that specifies the zero-based index at which the substring to return begins. 3 - An integer that specifies the length of the substring. From the central window, double-click on the Substring(‘’, , ) function to add it to the expression text. The substring function takes a string as its first parameter, in this instance the string is the field HEAD POSITION. Therefore, the quotation marks in the expression text are removed.
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Once more, selecting Fields in the bottom lefthand window, allows the selection and insertion of the field HEAD POSITION.Design BRANCH in lieu of the quotation marks. The field is enclosed in square brackets within the expression text.



Assuming the Head Position is in the format W 316640.00mm N 300879.99mm U 101349.77mm, the West coordinate may be extracted using the Substring function; starting at the first character and finishing at the character before the letter N. To achieve this, the 3 operands substring version is used. Between the two commas in the substring the starting position is defined. Enter 0 to indicate the first character. The next step is to locate the end position of the West coordinate; the Letter N. The CharIndex function may be used to achieve this location.







The CharIndex function can use four operands but, in this instance, only two operands are used: 1 – String to find. 2 – String to search in. In the expression text, place the cursor between the comma and closing bracket and in the bottom left hand window select Functions, before selecting the CharIndex function with a double-click to place it in the expression text. Between the first quotes of the CharIndex function enter the text ‘ N’ (space N).



Replace the second set of quotes of the CharIndex function with the field: HEAD POSITION.Design BRANCH to define the string to be searched within. Click OK to close the Expression Editor.



5.4.2.3 Entering the North Expression Using the same approach as the West Position in regards to the North coordinate, the string starts at the letter N and finishes at the letter U. From the CalculatedField Collection Editor select the HEADNORTHING calculated field. The CharIndex function can be used to return the position of the letter U within the original string. Using the Expression Editor, enter the expression: © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.



61



www.aveva.com



AVEVA Everything3D (1.1) Reporting TM-1803 Substring([HEAD POSITION], CharIndex('N',[HEAD POSITION]), CharIndex('U',[HEAD POSITION]) - CharIndex('N',[HEAD POSITION]))



The Substring function requires as a parameter the number of characters to return. Therefore the number of characters between the letter N and the letter U in the string is to be calculated to ascertain the number of characters to return. Taking the position: W 316640mm N 300879.99mm U 101349.77mm CharIndex('U',[HEAD POSITION]) - finds the position of the letter U = 25 CharIndex('N',[HEAD POSITION]) - finds the position of the letter N = 11 Therefore: CharIndex('U',[HEAD POSITION]) - CharIndex('N',[HEAD POSITION]) - returns the number of characters between the letters U and N to be 14 The expression evaluates to Substring([HEAD POSITION], 11, 14), which translates as a subtract of the string, starting at position 11, and continuing for the next 14 characters. Click OK to close the Expression Editor.



5.4.2.4 Entering the Up Expression Following the same process as the previous positions, in regards to the Up coordinate the string starting point and duration need to be ascertained. From the CalculatedField Collection Editor form select the HEADUPING calculated field, and using the Expression Editor, enter the expression: Substring([HEAD POSITION],CharIndex('U ',[HEAD POSITION]))



Click OK to close the Expression Editor. Click OK to close the CalculatedField Collection Editor form.



5.4.2.5 Adding the Calculated Fields to the Report Select the HEAD Position.Design BRANCH field label in the Detail Band of the report and click the associated > button at the top of the label to display the Label Tasks menu. Select the Data Binding option and select the HEADWESTING.Design BRANCH data field from the pulldown list of fields. Expand the Detail Band vertically downwards and add a new label; positioning it below the HEADWESTING label and altering the label size to match. Select the associated > button at the top of the label to display the Label Tasks menu. Select the Data Binding option and select the HEADNORTHING.Design BRANCH data field from the pull-down list of fields. Add a third label and position it underneath the HEADNORTHING label and alter the size to match the other labels in the column. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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Select the Preview tab and the resulting report, complete with data, should resemble the following:
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Exercise 4 Report Designer - Calculated fields Using the previous section as a guide, and the Worked Example report (Training_Report), complete the following tasks:  Add calculated fields to extract the West, North and Up co-ordinates of the Tail Position.  Resize the field labels on the Detail band to be the same height as the Head and Tail Position columns.  When previewing the report, note that the items are being split over the page breaks - to stop this from happening, select the appropriate label: Name.Design BRANCH (first one in the Detail row) and set it’s Keep Together property in the Behaviour section of the Property Grid to Yes.  Save the report.
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5.5



Sorting & Grouping – A Worked Example



Grouping enables the User to group parts of the report based on the returned data. It is possible to have multiple levels of Grouping, for example in the considered Branch List; the User may group the Branches based on the parent Pipe, Pipe Area and Status. Sorting allows the User to change the order in which the items are returned from the data source. Sorting can be applied to items within the standard bands of a report and items within groups alike. On the Report Designer tab, in the View group, select the Group and Sort option from the Windows button options list. The Group and Sort window is shown below:



The following sections explain the use of Grouping and Sorting.



5.5.1



Defining a Group



For the purpose of the Training Report, Grouping will be applied to group the reported Branches by the actual AVEVA E3D Model SITE they reside in. The first step is to add the Site to the report Data Source. Click the Report Designer > AVEVA > Data Source button to initiate the Data Source Wizard. Ensuring the Edit radio button is selected on the first wizard page, click Next > to navigate through the steps to the Columns step. Using the Columns step of the wizard, navigate to the Data Source Columns list and select the cell in the first row that contains the text Type Definition… Enter the definition: NAMN of SITE. Locate the new definition within the list and in the Name and Description columns enter: Site Name. The Data Type should be set to TEXT. Select Finish to close the Data Source Wizard.
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To add a Group, click the Add a Group icon located in the Group and Sort form. A menu is displayed listing the available fields that can be used for grouping the data. From the list of fields select: Site Name.



On selection, note that a GroupHeader1 Band has been added to the Report Canvas. The visibility of this band is controlled by the Show Header and Show Footer checkboxes on the Site Name row added to the Group and Sort window.







Because the Print Preview mode only displays a preview of the report formatting, the best way to view the result of applying Grouping and Sorting is to run the report using Report Designer > AVEVA > Run Report.



Running the report at this point in the task will reveal little. The report will not be altered until the User applies behaviour properties to the Grouping in order to change the report’s format. In this instance it is required that after each Grouping the report moves to a new page. To achieve this, a footer is added to the group to mark the last printed point in the group of reported items. To add the group footer, tick the Show Footer checkbox in the Site Name row in the Group and Sort window.
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Navigate to the GroupFooter1 band in the Report Canvas and in the Property Grid, set the Page Break property (within the Behaviour section) to After the Band.



Click the Report Designer > AVEVA > Run Report button and note the report contains additional pages (originally it had 9 pages) due to the grouping of the items inserting new pages after each Site. However, at present Site names are not being displayed and this may confuse the reader as to why the report is split across multiple pages. Additional information is required within the report to indicate to the reader that each report page is associated to a specific Site. Adding a label, bound to the Site Name.Design BRANCH field, to the GroupHeader1 band will not be sufficient for this purpose due to the group headers being printed once for each group of items. To achieve the placing of the label on every page, the label is placed either in the PageHeader or the PageFooter bands. In this case, the label will be placed in the PageHeader band so that it is printed before the grouped items. To facilitate an area to place the label, expand the PageHeader band by selecting the base of the band, and dragging the vertical limits handle downwards.



Select all the labels in the PageHeader band and, keeping the arrangement, move all the labels downwards.







The Arrow Down button can be used to move the labels down by one label’s height.



Drag a label on to the PageHeader band and enter the text SITE :. The label has a left text alignment and a text style Arial 12 Bold. Ensure the entire label text is visible by resizing the label.







Note that the placed label has inherited the formatting styles of the parent item.



Drag and align the Site Name.Design BRANCH field onto the PageHeader band adjacent to the Site : label The label has a left text alignment and a text style Arial 12 Bold. Ensure the entire label text is visible by resizing the label. With both labels selected, remove the borders and resize the PageHeader band so that it is aligned with the bottom of the column header labels, Click the Report Designer > AVEVA > Run Report and note how the report has changed; the Site name is now displayed at the top of each page, altering as the grouping changes.
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The first Report page will display an error for the Site name - recognisable by the red text stating: !Error. This error is due to the Branch being in an Administrative World and so does not have an owning Site.



5.5.2



Defining a Sort



Following on from the grouping of the Branches by the name of the owning Sites, the next step is to sort the data by the Branch Head Bore size.



In the Group and Sort window select the Add a Sort button from the menu bar to display a menu listing available fields that can be used to sort the data. Select the field: HEAD BORE.



The HEAD BORE field is added as an indented row under the Site Name group. The Show Header and Show Footer options are un-ticked as additional bands are not usually warranted for a sort task. Click the Report Designer > AVEVA > Run Report again and scroll to the page that reports the Branches of SITE-PIPING-AREA01. Note that all the Branches are now sorted by their HEAD BORE size: 15mm, 25mm etc.
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To make the report more useable, the Branches will also be sorted by their Length (Cut Length in metres). In the Group and Sort window select the Add a Sort button from the menu bar to display a menu listing available fields that can be used to sort the data. Select the field: CutLengthMetres..



The CutLengthMeters field is added as an indented row under the previous sort field HEAD BORE.



Click the Report Designer > AVEVA > Run Report again and scroll to the page that reports the Branches of SITE-PIPING-AREA01. Note that the branches are now sorted by the HEAD BORE and then the LENGTH.
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The sort order may be altered from default Ascending to Descending by changing the Sort Order field of the respective sort rows.



Alter the CutLengthMeters row Sort Order from Ascending to Descending. Click the Report Designer > AVEVA > Run Report and navigate to the page that reports the Branches of SITE-PIPING-AREA01. Note that the branches are sorted by the HEAD BORE but, on this occasion, the LENGTHs are listed longest to shortest.



5.6



Final Formatting Tasks (Worked Example)



On finalising the contents of a report, the User may wish to add additional information regarding the associated project, date or the display of page numbers.
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5.6.1



Project Info Control



Considering Report Designer reports are portable between projects, rather than hard coding the project name or number in a text label within the report, it is prudent to add labels at the point of report preview or running whereby the current project’s system database is accessed and returns the information required.



On the Report Canvas, drag and drop a Label in a location on the left-hand side of the top margin above the ReportHeader Band. By double-clicking the label, add the text Project : and then set the text justification to the Right.



From the AVEVA Tool Box, drag and drop a Project Info control next to the Project : label placed in the top margin. The Project Info control contains no display text.



With the Project Info control still selected, navigate to the Property Grid and select the Value property in the Data section of the grid. From the associated pull-down list of values select the value Project Name.
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The selection will place the current project’s Name as the display text of the label i.e. TRA On the Report Canvas, drag and drop a second Label in a location on the left-hand side of the bottom margin. By double-clicking the label, add the text Generated by: and then set the text justification to the Right. From the AVEVA Tool Box, drag and drop a Project Info control to an adjacent position and set the Value to User Name. Switch to Print Preview mode and note the result.



5.6.2



Page Numbering



Page numbering may be added to the report by using a Page Info control available from the Tool Box menu. It is custom to place these controls within the Report Page Header/Footer or margins.



Drag and drop a Page Info control onto the Report Canvas within the bottom margin, and align it with the right-hand margin. By default the Page Info control displays 1/1. On running the report, the Page Number is displayed as: /. The User can alter the page numbering format by changing the Page Info control Page Information property within the Property Grid. The standard options available for page numbering are presented in the following Table. Example of Numbering



Property Setting



Description



“Current of Total” Page Numbers



The current page and the total number of pages (Default)



Page Number



The current page



1



Page Number (Roman, Lowercase)



The current page in lowercase roman numerals



iv



Page Number (Roman, Uppercase)



The current page in uppercase roman numerals



IV



3/45



Alternatively, the User can define a bespoke page numbering format by changing the Format property in the Property Grid. To change the default 1/1 format to display Page 1 of 1:  Select the Page Info control and ensure the Page Information property setting is set to “Current of Total” Page Numbers.
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5.6.3



Adding the Date and Time



To add Date and Time information to the report, the Page Info control is again used from the Tool Box. Drag a Page Info control onto the Report Canvas top margin and align with the right-hand margin as shown. Initially, the control is added as a page number counter and therefore displays the text 1/1. To accommodate the display of the Date and Time increase the size of the control by dragging the left grab handle. Click the > button on the control to display the Page Info Tasks menu. From the Page Information pull-down list select the Current Date and Time option.



The control will update to display the current Date in the format of Day Month Year. To change the format of the Date and Time, use the Page Info Tasks menu and select the button adjacent to the Format property to display the FormatString Editor.
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Using the FormatString Editor select DateTime from the Category list and beneath the Standard Types tab standard ways of formatting the date and time are listed. The Sample window updates to display a preview of any selection. Select dd MMMM yyyy hh:mm tt from the Standard Types list and click OK to close the editor. The Page Info Task menu will now reflect the selection as the Format and the actual control on the report will be formatted in the chosen way. Click the Report Designer > AVEVA > Run Report and note the time and date format.



5.7



Setting the Scope of the Report – A Worked Example



In addition to a User setting expression and attribute filters when defining the Data Source, the scope of the report may be defined. The Scope can be inclusive of named items and their child items, the current drawlist or a defined 3D volume. Click the Report Designer > AVEVA > Scope.
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The top part of the Scope form contains a list of the Root Elements to be searched within when the From field is set to MDB (or the scope) of the report. To add items to the list, the AVEVA E3D Model Explorer can be used to navigate to an item before clicking the Add CE button to append the item to the Root Element list. To remove an item, the item is selected in the Root Element list and the Remove button clicked.



The From field and pull-down list allows the User to select the search hierarchy. The available options are:







 MDB



Searches the MDB hierarchy and is dependent on the items listed in the Root Elements list. The report will be restricted to source data at and below the level of these elements in the element hierarchy. Where the list is empty, the MDB will be searched from World (/*) level downwards.



 Drawlist



Sets the Scope to the current items that in the User drawlist.



 Obstruction List



Sets the Scope to the current items that in the User obstruction drawlist.



Care must be taken to ensure the From field is populated. Unexpected results may be returned if this field is not populated.



If the scope of the search is to be restricted to a volume, the User can utilise the Volume field and the available pull-down options. These options allow the User to set the search for items to be either Partially Within or Completely Within the specified volume.



The Volume form is displayed for either selected Volume option. Depending on the coordinate grid system being employed, the User can right-click on the Format  label to define the format via a context menu to Format XYZ, Format ENU or Format Grid coordinate input. Using the Volume form fields, the User can enter the Volume bounding box diagonal coordinates or grid positions.







There is no 3D graphical selection available; all the values have to be directly entered in the available fields.



To close the form, click the OK button.
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5.7.1



Setting the Scope



Considering the Branches Report formed as part of the continued Worked Example, the Base Element type is selecting and reporting on all the Branch items from the current MDB. This selection extends to HVAC elements; these are not required for a Piping Branch list report. To remove these elements from the report, the scope is restricted to report solely on the Sites that contain Piping elements.



Click the Report Designer > AVEVA > Scope and in the Model Explorer select the SITE /SITE-PIPING-AREA01 and click Add CE. Repeat the action by adding the other two piping SITES for the plant: /SITE-PIPING-AREA02 and /SITE-PIPINGAREA02.



Ensure the three selected sites are the only items listed in the Root Elements list, and the From field is set to MDB. Click the OK button to close the form. Click the Report Designer > AVEVA > Run Report and note how the scope is now restricting the items returned to be only the Branches within the three listed sites.



5.8



Reporting via Charts – A Worked Example



Report Designer presents the ability for the User to incorporate Charts and Graphs in a report. A report can be formed exclusively by various Charts, illustrating the Data Source elements and presenting different categories of information, or a report may be formed by a combination of textual and Chart reporting elements. A selection of Charts is available to the User and can be generated in 2D or 3D orientations. As a User, the styling for each individual part of the Chart may be defined as found with report controls. The data to be presented in the charts can include any of the data fields originated from the associated data source and any user-defined calculated field.
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5.8.1



Chart Wizard: Adding a Chart



Continuing the Worked Example Branch List Report, a Chart will be added to the first page of the report. Currently the ReportHeader band is the height of the report title label; vertically increase the band height to enable the insertion of a Chart.



From the Tool Box (Standard Controls), drag a Chart control onto the ReportHeader band to place a bounding box representing the area of the chart. The size of the chart may be modified later in the task. The dropping of a Chart control onto the Report Canvas will automatically start the Chart Wizard.



The Chart Wizard aids the User in forming a report Chart through a series of steps (explained in following sections) that utilise a series of Construction and Presentation chart tools.



5.8.1.1 Chart Type The first step of the Chart Wizard is to define a Chart Type. This decision is largely dependent on the data to be presented and may be modified at a later point if required. For the purpose of presenting the Branch List data, a 2D Bar chart will be used. The pull-down menu below the main Chart Type title filters chart types by their groups. By default All Chart Types are displayed for selection. Select the Bar graphic.
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Click Next >> to continue the next page of the Chart Wizard.



5.8.1.2 Appearance The Appearance page of the Chart Wizard allows the User to choose the appearance of the (Bar) Chart by specifying a colour palette Select the Palette pull-down list and select the option Nature Colors. Leave the Style pull down list as Nature Colors (all Colors)



Click Next >> to continue the next page of the Chart Wizard.



5.8.1.3 Series The next step of the Chart Wizard allows the definition of the number of Series values that are required to be displayed on the Chart. By default there are two Series for a bar chart: Series 1 and Series 2. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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For the Worked Example, only one Series is required. Select Series 2 in the list and click the Remove button. The User must also ensure that the Series argument and value scale types are defined appropriately. Declaring an accurate scale type (qualitative, numerical, or date-time) for the series point’s arguments and values is crucial for getting the correct output later For the identified Chart the default values are acceptable. Click Next >> to continue to the next page of the Chart Wizard.



5.8.1.4 Data The next step of the Chart Wizard provides the User with options for populating the Series with points. This process can be either completed manually by specifying arguments and their values for each point via the Points tab or, if the chart's data source is known, completed automatically by specifying the data bindings for the series via the Series Binding tab. In this case, the data source to bind to is known and the User only has to provide the Argument Properties and the Value Properties Select the Series Binding tab to enable the specification of the data source settings for the Series 1 points.
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In respect to the Argument Properties section of the form:



Navigate to the Argument scale type: field and select the Qualitative option from the pull-down menu.







The qualitative scale type represents the values of series points as ordinal textual values on an axis.



Select the Argument: pull-down option to display a list of the data source fields available and select the field: PSPE.Design BRANCH. The menu will close and the field will be placed as the Argument property.



In respect to the Value Properties section of the form and how the data is returned: Navigate to the Value scale type: field and select the Numerical option from the pull-down menu to reflect the numerical nature of the displayed data. As a count of the branches for each specification is required, the Binding mode: is set to be a Summary Function from the pull-down list.
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To choose the type of Summary Function: required, the adjacent is clicked to prompt the Summary Function form.



button



From the pull-down list select the COUNT option and click the OK button to close the form and update the Value Properties fields.



Click Next >> to continue to the next page of the Chart Wizard.



5.8.1.5 Advanced Appearance The Chart step of the Chart Wizard allows the User to adjust the chart's appearance.



The chart background colour, fill style, background image, and borders may all be altered via a series of tabbed options.



As the default values are acceptable, click Next >> to continue to the next page of the Chart Wizard.



5.8.1.6 Diagram The Diagram step of the Chart Wizard allows the User to customise the chart’s properties.
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Each chart type has a specific list of settings and chart elements including axes and secondary axes. These elements may be added and removed, in addition to enabling zooming and scrolling within the Chart through a series of tabbed options.



As the default values are acceptable, click Next >> to continue to the next page of the Chart Wizard.



5.8.1.7 Panes The Panes step of the Chart Wizard allows the User to change the background pane of the Chart.



The pane may be selected directly by clicking in the chart preview area of the wizard and customised using the available options/tabs. The User is able to specify the pane appearance, border, shadow, scroll and zoom, fill style and background.







Some charts do not have a pane and therefore this step may be skipped.



As the default values are acceptable, click Next >> to continue to the next page of the Chart Wizard.



5.8.1.8 Axes The Axes step of the Chart Wizard allows the User to set options for the primary and secondary axes including their alignment, visibility and ranges. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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The tabbed options allow the User to change the properties that belong to the axes, such as the axis title, grid lines and tick marks, and axis labels.







To select an axis, you can click it directly in the chart preview.



As the default values are acceptable, click Next >> to continue to the next page of the Chart Wizard.



5.8.1.9 Series Views The Series step of the Chart Wizard allows the User to set the display properties for the series including the appearance, background colour, fill style or background image, border colour, and shadowing. The report requires all the chart bars to be of an equal width. To achieve this, select the General tab and in the Bar Options section tick the Equal bar width checkbox. Unlike the preview image, each chart bar is required to be a different colour. Select the Appearance tab, and tick the Colour each point checkbox as shown



Click Next >> to continue to the next page of the Chart Wizard.
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5.8.1.10 Point Labels The Point Labels step of the Chart Wizard allows the User to customise the appearance of the labels which accompany the series points



The labels above the columns of data may be modified through a series of tabbed options. Click Next >> to continue to the next page of the Chart Wizard.



5.8.1.11 Chart Title The Chart Title step of the Chart Wizard allows the User to add title(s) to the chart - an unlimited number of textual titles are possible. Each title position and appearance can be individually adjusted using the available options on the tabs.







To select a chart title, you can click it directly in the chart preview.
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Delete any existing text and enter: Branches by Specification



The Preview pane updates as the title text is entered and populates the Titles list: pull-down menu.







The General tab allows you to change the titles formatting style



Click Next >> to continue the next page of the Chart Wizard.



5.8.1.12 Legend The Legend step of the Chart Wizard allows the User to add or remove a legend for the reported chart data.



Where a legend is required, the position relative to the chart, appearance, background colour, fill style, or background image, border colour, and shadowing and call all be specified through the available tabbed options. In this instance, the Chart contains Specification details as its x-axis values and a legend is not required. Select the General tab, and un-tick the Visible check box as shown.



Click Next >> to continue the next page of the Chart Wizard.



5.8.1.13 Annotations The Annotation step of the Chart Wizard allows the User to add text and image annotations anchored to the chart, panes, and series points.
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Through the Annotation list: and tabbed options, annotation can be defined and modified in respect to their position, layout, appearance etc…



Click Finish to close the Chart Wizard.



The completed chart should now be visible within the ReportHeader area of the Report Canvas. To resize the chart, select the chart and using the grab handles on the control, stretch the bounding box to the desired size. Click the Report Designer > AVEVA > Run Report and note how the Chart is incorporated into the report.
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5.9



Summarising Report Data - A Worked Example



Often a report will contain summaries of the reported data e.g. total material length or total number of reported items. The following example will outline the process of adding a summary through the addition of a summary label that counts all the report items within each reported group. A Table control will be created to keep the created summary labels together. To add a Table, select the Table control from the Tool Box (Standard Controls) and drag to a point to the right of the created chart in the ReportHeader area of the canvas. The default table bounding box is larger than a normal label control, as by default it is placed on the canvas with three columns. Each table cell is individually labelled. The report requires a table formed by one column and two rows. The number of columns and rows can be altered via a right-click context menu containing additional table layout options. Select the right hand column cell of the table and, using the right-click menu, select: Delete > Column to delete the column and resize the remaining columns to suit the boundary box area.



Using the same process, delete the second cell forming the row. To add the required second row, select the remaining cell and using the rightclick menu select: Insert > Row Below.



To reduce the table width, select the table control and navigate to the Property Grid. Select the Size property in the Layout section and change the value to 280, 50 as shown. As described earlier, alter the top cell text to: Total Branches and change the style to Arial, 11pt, Bold. Ensure the table cells are set to Text Alignment: Middle Centre. The Table will now resemble the following:



The next step is to bind the table cell ‘tableCell4’ to a Data Field – following the same procedure described for a label control. Select the bottom cell of the table, and click the associated > button at the top right corner to display the Table Cell Tasks menu. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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Now that a Data Field is bound to the cell, the Summary information is required to be set i.e. what the cell will display on the report. Click the



button in the Summary field to display the Summary Editor form.



The purpose of the table is to perform a count of the number of branches in the report, therefore the Summary function is altered to Count, and the Summary Running set to be Report - the counter is for the whole report. Click the OK button to close the form.



The bottom table cell is updated to show the Summary function and the field it is being applied too.



Before running the report, select the ReportHeader band and in the Property Grid set the Page Break value to After the Band. This will insert a new page after the Report header has been printed.



© Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.



88



www.aveva.com



AVEVA Everything3D (1.1) Reporting TM-1803 Click the Report Designer > AVEVA > Run Report and note the first page should display a chart illustrating the different Piping Specifications referenced in the project and a table summarising the total number of branches that are in the report.



To produce a branch count within each of the Groupings, select the table control on the ReportHeader band and copy/paste to a suitable position in the GroupFooter1 band of the report using normal keyboard controls (Ctrl+c and Ctrl+v). Select the bottom cell in the copied table and click the > button at the top right corner to display the Table Cell Tasks menu.



Click the button in the Summary field to display the Summary Editor form. Due to the summary applying to a Group this time rather than the report, set the Summary Running to be Group. Click the OK button to close the form.



Using the AVEVA Toolbar, Run the Report again and note the summary table associated with each reported grouping.
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Exercise 5 Report Designer - Summarising Structural Steel Report Using the Branches Worked Example report (Training_Report) as a guide, complete the following tasks:  Re-create the summarising structural steel report that you created for Standard Reporting (Error! Reference source not found.) using Report Designer.  The report must include the profile name; the description of the material reference, the profile cut length, the gross weight, the net weight, the gross surface area, the net surface area and the number of pieces.  The report must be subtotalled when the profile name and description of the material reference change.  All numeric columns must be subtotalled and totalled.
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Exercise 6 Report Designer – Branch Members Report Using the Branches Worked Example report (Training_Report) as a guide, complete the following tasks:  Re-create the branch members report that you created for Reporting using the Report Designer.  The report must include the profile name; the description of the material reference, the profile cut length, the gross weight, the net weight, the gross surface area, the net surface area and the number of pieces.  The report must be subtotalled when the profile name and description of the material reference change.  All numeric columns must be subtotalled and totalled.
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CHAPTER 6 6



Report Designer - Quick Reports



The following Chapter will describe the use of the AVEVA E3D Search and Collections to create a Quick Report by binding the search results to a Report Layout Template.



6.1



Creating a Quick Report from Search results



The Search function enables the databases to be searched for specific items. The scope of the search may be defined and the items may be identified by different criteria including name, type, and attributes.



On the Home tab, in the Search group, click te button Search to display the Search form.



Click More Search Tools link label and following form will be presented:
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The following sections describe the elements of the Search form used to form a search result suitable for the creation of a Quick Report.



6.1.1.1 Name Contains



The items to be searched for may be specified by names that contain a specific string, one or more element types or a combination of both.
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6.1.1.2 Element Type



One or more valid AVEVA E3D element types may be entered in the Element Types textbox that will form the basis of the data produced in the report. If more than one item type is entered they must be separated by a space, comma, or semi-colon, i.e. EQUI PIPE, NOZZ; TEE. The entries may be any valid item types and are not case sensitive. The options list contains an ALL option (the default) which, if selected, will find all item types in the current search scope.







Consideration should be given when entering multiple element types, to the attributes that will be used in the quick report. Element types that have few attributes in common may, depending on the attributes used, have many ‘null’ columns.



The reserved word MEMBERS may be used in conjunction with different element types. For example, entering BRAN MEMBERS will report on all of the members of a Branch (BRAN), e.g. ELBO, TEE, VALV, GASK, FLAN, etc.



6.1.1.3 Search Filters The Search Scope fold-up panel contains two methods to specify the search scope; a hierarchical search below a ‘ceiling’ or a volumetric search within a specified volume. Each of these methods may be used separately or they may be combined.



The ‘ceiling’ may be changed by entering a valid item name in the textbox or clicking the CE button to set the current element as the ‘ceiling’ for the search.







When the Search is first opened during a session, the default scope will be set to the current element as the ‘ceiling’ of the search within the current database, e.g. Model, if within the Model application.



As well as searching specific database types via the In Database option list, it is possible to narrow the scope of the search further. This activates a number of options available via the adjacent pull-down list.
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Checking the In Volume checkbox activates the Of Element and Explicit Volume radio buttons. Selecting the Of Element radio button enables an element to be selected in the Model Explorer and then the CE button clicked to set the search volume to the bounds of this element. The elements entered in the Of Element options list will be retained throughout the current session; however, this history can be cleared by selecting Clear History from the options list. Checking the Explicit Volume checkbox activates the textboxes in the Lower Limit and Upper Limit areas of the fold-up panel, enabling the opposing corners of a box to be specified by entering the X, Y and Z co-ordinates to define the volume explicitly. The Wholly Within and Wholly & Partially within radio buttons, which are applicable to both methods of volumetric search, specify whether the found items exist completely or partially within the specified volume.



6.1.1.4 Attribute Filters The Attribute Filters fold-up panel enables one or more attribute filters to be set for the search. The specified attributes will apply to each item type listed. If there is more than one attribute filter specified then the found items will satisfy all of the attribute filters. The Add Filter and Delete Filter link labels at the bottom of the fold-up panel enable an attribute filter to be added and deleted as required.







Where the search is being used as the basis of a report, the User is also able to add filters within the Reports Definition.
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6.1.3



Running the Search



Clicking the Search button will execute the search and the results will populate the grid of the Collections Window.







The Collections form may be opened at any time by clicking on the Home tab, in the Search group, button Collections.



The Collections form displays the results in a grid gadget. Each column of the grid represents an attribute of an item in the database(s). The columns to be displayed can be specified and the results can be grouped, sorted and filtered. Some attributes in the results grid may be edited individually or by bulk editing.



Attributes (Columns) can be added and removed from the search results grid by right mouse clicking on the heading row of the columns and, on the context menu, selecting the Column Setup… option.



This will display the Column Setup form. On this form the User can enter the attribute name and a column heading, including UDA and Pseudo attributes. As well as attributes, valid AVEVA E3D expressions can be entered to return more purposeful data, for example:



Expression



Resulting Column Data



PURP OF OWNER



Returns the value of the Owning items Purpose attribute



HBORE GE 100



Displays true or false depending on the HBORE’s NB



MCOUNT



Returns the number of members of the item in the search



NAMN OF SITE



Displays the name of the items owning SITE without the leading slash
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Displays the name of the items owning items owner without the leading slash







The order of the attributes in the Column Setup form, will be the initial order in the report, however these can be re-arranged in the Report Designer later if required.







If the width of the columns in the Collections grid is changed, then this will be reflected in the report’s initial layout.



6.1.4



Create Quick Report



On selection of the attribute columns to be reported upon, the Quick Report… option may be selected via the right-click context menu when the cursor is located within the Colletions grid header bar. The Quick Report form is displayed.



The Quick Report form displays potential Layout Templates of differing styles and size to be used as a basis for a report. The User is able to populate the available Layout Templates by navigating via the Look In pull-down to a suitable Project, User, Product or file location. On selection of a Layout Template from the list, a preview is displayed in the Layout Preview area of the form.



To create the report, the Open button is clicked and the User is prompted to apply a default layout to the selected report Layout Template.



On clicking Yes the report is processed and the Quick Report Designer – New Report window is displayed in Print Preview mode; the report is populated with the stipulated data within the report Data Band. If the User selected No on the default layout confirmation message, the Report detail band remains unpopulated and the User is required to manually define the layout of the fields (attributes).
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6.1.5



Creating a Quick Report – A Worked Example



In this Worked Example a simple report of the pipe branches in the ZONE /ZONE-PIPING-AREA01 will be produced. The report will be modified to show only branches of certain specifications. Working in the AVEVA E3D Model module, click the Home > Search > Search button to display the Search form.



In the Search form enter BRAN in the Element Type: textbox. Ensure the Track CE checkbox is ticked, and /ZONE-PIPING-AREA01 is current in the Model Explorer. Add a Filter to the Attribute Filters list that has an Attribute of HBORE, select Greater than or equal to from the Operator pull-down list and enter 100 in the Value field. This search will only find those branches in the ZONE whose head bore are greater or equal to 100mm.



Run the search by clicking the Search button. The results will be displayed in the Collections window.



The search result attributes need to be extended for the scope of the report. Using the right-click context menu within the search grid column headers, select the Setup Columns… option to display the Setup Columns form.There is no requirement to report the Type attribute. Select Row 2 which should have the Expression of Type, and uncheck the Visible cell as shown. Using the Add Column link on the form, enter the attribute name PSPEC as the Expression in the new row; leave the Heading as the system default. © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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Once all of the attributes have been entered into the Expression column, click the OK button to refresh the Search Results grid. The grid is updated with the addition of the new columns, filled with the relevant data from the database. Expand the Collections form and adjust the widths of the displayed columns to show all of the data. To adjust a column width, select the gap between the column heading (note the cursor will change to a ) and holding the left mouse button, move the cursor left and right. The Search Results grid will now be as follows:



Now that the required data has been established and collated, the creation of a report is required. Right click on the Search Results column header row and select the Quick Report… option from the menu. The Quick Report form will be shown: © Copyright 2012 to current year. AVEVA Solutions Limited and its subsidiaries. All rights reserved.
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Select the A4-Landscape template from the list of Product layout templates, noting any preview displayed in the Layout Preview window. Click the Open button to select the template. On being asked whether to Apply default layout to selected report layout template, click Yes to automatically apply the column layout to the report template.







Applying the default layout will take the exact layout of the Search Results grid and apply it to the Report Template. If the default layout is not selected, the User must drag columns onto the page and size them to suit the report requirements.



The report will now be displayed in the Print Preview tab of the Quick Report Designer – New Report window.
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AVEVA Everything3D (1.1) Reporting TM-1803 The Print Preview will display the data, laid out as per the Search Results grid, and allows verification of data and layout before running the report. On verifying the report is adequate, click Print Preview > Export > Export To > PDF File option to display the PDF Export Options form.



The form may be used to enter any relevant information regarding the report or set security options. Click the OK button. The Save As dialogue will be displayed. Enter Branch List Area01.pdf in to the File name: textbox.







The default folder in which Quick Reports are saved is: C:\AVEVA\Plant\E3D\Data1.1.0\ USERDATA\ \Data\Reports, where is the current project 3 letter code.



Click the Save button to save the report to the file system.



The prompted Export form presents the option to open the file, click Yes.
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Close the PDF view of the report. If one wanted to change the reported search results, for example to report on all the Branches that have a HBORE GE 100 and also have a PSPEC of /A1A, the User has two options:  Repeat the Quick Report process following a change to the Attribute Filters on the Search form.  Filter the contents of the current Quick Report within the Quick Report Designer without having to rerun the search. Considering the second option, navigate back to the Quick Report Designer – New Report window and select the Report Designer tab.
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Ensuring the report is current, navigate to the Property Grid and select the option A4 Landscape Report from the top pulldown list of the Property Grid.



Navigate to the Data section and select the property Filter String and click the adjacent FilterString Editor window.



button to display the



In the FilterString Editor window, select the Visual tab to be presented with the text link And . On clicking the link, a list of the associated available conditions is listed. Select the text link word And; from the list of options select Add Condition to spawn a new branch from the And.



Select the Name link to present a list of the Fields (attributes) that are available in this report. Select Pipe Specification from the list. From the list of operands select = Equals. Finally select the link. In the text box enter the text A1A. Close the window by clicking the OK button.



The Filter String property should now be set. To see the result of the filter on the currently searched items, select the Print Preview tab and the resulting report should look similar to this:
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Exercise 7 Report Designer - Quick Reports Using Chapter 6 as a guide, complete the following tasks:  Search for all the nozzles of the equipment in the ZONE /ZONE-EQUIPMENT-AREA01 of the Training Project. The report must include the owners name, the nozzle name, the nozzle nominal bore, the nozzle position and orientation and the connection reference, if any.  Create a Quick Report of the Search Results grid.  Output the report as a text file named Nozzles.txt.  Use the Filter String to report only the nozzles that are not connected, i.e. the nozzles that have a connection reference of Nulref, and save the report as a pdf file named UnConnected Nozzles.pdf.
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Report Designer - Running a Report



Having established the report creation process for Report Designer, the following Chapter will outline how the defined reports can be retrieved and run as part of a project.



7.1



Running a Report A Worked Example



Reports created in Report Designer can be shared across a project or organisation and run directly from the Report Definition (.repv) file. As previously discussed, the Report Definition file defines the report presentation and Data Sources. To run a report, click Tools > Report > Designer button to display the Run Report form.



The User can locate an appropriate report using the Look In pull-down menu and selecting Product, Project, User or Browse. If Browse is selected, the User is able to locate a report across the file system. With the Product level selected, choose the DESIGN-Valve_List from the list of reports under the Report Definition tab.







If the report has parameters that need to be entered the User will be prompted to supply the data.



On selecting the report a preview of the report contents, excluding actual database data, will be shown in the Layout Preview window of the form.
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The Run button is now available for selection and may be selected if all is correct. The resulting report will be shown in the Run Report window, as shown below:



Export report to PDF document.
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Exercise 8 Report Designer - Quick Reports Using Chapter 7 as a guide, locate and run the reports created in Chapters 5 and 6
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